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Goals

@ esri

Understand what spatial analysis is.

Understand why spatial analysis is a unique
characteristics of GIS and why it is powerful in
education and in greater society.

Build skills in spatial analysis using ArcGIS
Online.
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What i1s GIS I?

1. Classical Definition: GIS is atool that can access,
Integrate, and distribute layers of map information. The
five parts of a GIS include hardware, software, data,
procedures, and people.

2. A more Modern Definition (?): GIS lets us visualize,
guestion, analyze, interpret, and understand data in

new ways. This can reveal relationships, patterns, and
rends.
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What is GIS I1?

3. Give it some context: A transformation is taking place.
Businesses and government, schools and hospitals, nonprofit
organizations, and others are taking advantage of it. All
around the world, people are working more efficiently because
of it. Information that was limited to spreadsheets and
databases is being examined in a new, exciting way—all using
GIS.

4. A workflow definition: People intuitively understand maps.
When a decision needs to be made, GIS helps us gather
iInformation and place it on a digital map. We then use GIS to
evaluate the decision geographically. Once we fully
understand the geographic consequences of the decision, we
can act in an informed, responsible manner.
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What is GIS I117?

5. The value proposition: The benefits of GIS generally fall
Into five basic

categories:

. Cost savings resulting from greater efficiency
. Better decision making

. Improved communication

. Better geographic information recordkeeping
. Managing geographically

6. Or, asimple definition: GIS helps us see where things
are—and decide where they should be.

Bottom line: GISis more than maps. Itis more than
visualizing. It allows us to do spatial analysis.
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What is spatial thinking and analysis?
My working definition of spatial thinking:

“Identifying, analyzing, and understanding the location, scale,
patterns, and trends of the geographic and temporal relationships
among data, phenomena, and issues.”

Esri Definition of Spatial Analysis: “The process of examining the
locations, attributes, and relationships of features in spatial data
through overlay and other analytical techniques in order to address
a question or gain useful knowledge. Spatial analysis extracts or
creates new information from spatial data.

Or: It is how we understand our world — mapping where things
are, how they relate, what it all means, and what actions to take.
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Components of Spatial Analysis

- Understanding where.

- Measuring size, shape, distribution

- Determining how places are related
- Finding the best locations and paths

- Detecting and quantifying patterns

spatial ANALYSIS

- Making predictions AR T |

http://www.esri.com/products/technology-topics/spatial-analysis

https://dl.dropboxusercontent.com/u/91042629/The Lanquage of Spatial

Analysis 2013.pdf
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Is this spatial analysis?

ChangeMatters Viewer
Pan and zoom around the maps to understand earth changes that have happened over time. Advanced
change detection tools are also available by clicking any full screen button.
& Instructions

View larger

= T S

ChangeMatters - Infrared

Select Image Ma

1975 o s ) 2000 i s ) NDVI Change for 1975 to 2000

! |Snow/Ice 8 Urban .Water ™ 3 Clouds .Wet[ands .Veg Increase aVeg Decrease

-

‘Agriculture - Conifer Forest - Desert - Broadleaf

How to interpret a change image
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You need data and tools to do spatial analysis!

Finding and Using Spatial Data

Old Paradigm

--Download data=> Unzip-> Format-> Project=>Tabular
Manipulation-> Use.

New Paradigm

--Access data in cloud= Use.

We are not quite to the point of fully using the new
paradigm ... yet.
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Thus, best practice today is still the hybrid model:
1. Start with ArcGIS Online to search for data.

2. Search local, state, national, international data
depositories and portals.

Examples:

Local: Boulder County CO, Los Angeles County CA

State: www.tnris.org (Texas), CASIL (California), RIGIS
(RI), NRIS (MT)

National: USGS, NASA, Census Bureau, NOAA, EPA, US
DOT, USFWS, BLM, USFS, FAA, National Atlas,
LINZ (New Zealand), IBGE (Brazil), OS (UK)

International: WRI, WWF, UNEP, World Bank, Natural Earth

Data
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What kinds of data can you add to ArcGIS Online?

Data Type Open in ArcGIS  Open in ArcGIS
Online Desktop

Map Notes X

Tables (CSV) X X

Zipped Shapefiles X X Unzip first

Zipped other data X after unzipping X after unzipping
and serving

Images (JPG, X X

PNG, TIF)

Feature services X X

Layer package, X

map package
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Data Types and Sources

1) Vector: Shapefiles, geodatabases, feature
services, other vector formats.

2) Raster: ArcGrids, GeoTiffs and other images,
Tiled image services.

3) Tabular: Excel tables, CSVs, TXT files, other

formats.
4) Ground images: Wikipedia and other creative

commons sources.
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Data Sources and Issues (privacy, crowdsourcing,
cloud vs. desktop, copyright, and how to use).

The GIS Guide to Public Domain Data, by
Joseph Kerski and Jill Clark, Esri Press

http://spatialreserves.wordpress.com

Spatial Reserves

" About the book About the authors Exercises and data for the book Related sites

Type text to search here a

% Home > Public Domain Data > Listing of Free GIS Data Sources from Robin Wilson

Listing of Free GIS Data Sources from Robin Wilson

™ November 10, 2013 ) josephkerski ') Goto comments G} Leave a comment

As we discuss in the book The GIS Guide to Public Domain Data, listings of spatial data sources
have existed since the dawn of the web. Those of you who have been around GIS as long as
I have might remember such lists as the Oddens Bookmarks, which already contained over
5,500 categorized references by 1998, and the Alexandria Digital Library Project from UCSB.
The objective of these lists has always been, if not to eliminate, to at least reduce the need
for each of us in the field to maintain our own lists. While Internet search engines have vastly
improved over the past 20 years, listings still have their place and are still useful, because
search engines do not always pick up the relevant data and tools that the geospatial
community is seeking.

With the crowdsourcing tools available to us nowadays, though, is it not possible for
someone or an organization to create a crowdsourced listing of geospatial data? To maximize
the utility of such a resource would require someone vetting the list to make certain that only
relevant items are approved. Perhaps a reader can comment on this post to let the
community know if such a project exists or is in the works.

In the spirit of being helpful to the geospatial community, Robin Wilson, PhD student at the
University of Southampton, created the resource "Free GIS Data”

on http://freegisdata.rtwilson.com/. Robin's index is one of the more useful I have seen and
is frequently updated. It contains over 300 sources with headings of physical geagraphy,
cultural geography, as well as data about specific places. One of the most helpful things
about the resource is Robin's brief but very useful 1-2 sentences about each resource, which
serves as a useful bit of metadata to guide the user.

@ 1 freegisdata.stmilson.com
s ) oomsion @ o ove o

W et o

This page contains a categorised list of knks to over 300 sites providing freely avaiable,
geographic datasets - all ready for loading into a Geographic Information System.

RSS feed Q Twitter

Confributors

RecentPosts

@ The secret lives of phones: someone,
somewhere knows where you are
Digital Preservation and Formats from
the US Library of Congress

WorldPop - Population

distribution data

Listing of Free GIS Data Sources from
Robin wilson

Google's public data program

Recent Comments

The secret lives of phones: someone,
somewhere knows where you are |
GIS Tidings on The secret lives of
phones: someone, somewhere knows
where you are

Digital Preservation and Formats from
the US Library of Congress | Bhojaraju
Gunjal on Digital Preservation and

Joseph Kerski

Formats from the US Library
of Congress
Digital
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10 Spatial Analysis Exercises
In the Public Domain Data Book

Exercises for GIS Guide to Public Domain Data book sucnto | Asoymap ¥ &
These 10 exercises for the GIS Guide to Public Domain Data book build skills in discovering, assessing, formatting, and using spatial data in a GIS environment, as well builder mode
analysis to make real-world decisions with those data. For more information, see http://spatialreserves.wordpress.com
SOUTH DAKOTA WISCONSIN
. Fierre /
Exercise 3
Sioux @ :
Falls . \\‘-—n“g\,;sl 5 W
; i o
Exercise 3: Siting a fire tower in the %, Madison
Loess Hills of Nebraska, USA &, %
Siting a fire tower o o _ Sawnop R R IOWA : e X
in Loess Hills, - = s 7 < @ % iy o Jgect
Nebraska % 1y NEBRASKA Des 07 7,
i et Moines .,
S : Lincoln
) Plyypte o]
\ 4
InE ise 3 det ine th timal sit D
Exercise 3: Siting a n Exercise 3, you determine the optimal site P
: 9 for a fire tower in the Loess Hills of Nebraska, Springfieldo
fire tower in the USA, by examining elevation, slope, aspect, §
Loess Hills of land cover, and distance to streams using Lo s JKansas City Saidh &
data from the USGS and a data conversion Topeka : 1500 re Moty
Nebraska, USA program. EANaAS Jefferson C|ty°' Missay,, oLouR,\ o
Y faYed A
Arkansas NHD Plus, NPS, Esri, DeLorme, FAO, USGS, EPA, NO... S i i

Exercise 3: Siting a fire
tower in the Loess Hills
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¢ Finding and using data on ArcGIS Online

--Often helpful to narrow the search, such as:

quotes “riparian zones”

--Keywords:

<search string> owner:jjkerski or tags: “bike
lanes”

--Use Boolean operators:
“recent fires” OR fires
owner:esri AND tags:streets

--search in your specific map extent or in your
organization

More tips on: Using Search — Fields:
http://[resources.arcgis.com/en/help/arcgisonline/index.html#/
/010g0000000n000000

¢ Accessing and using data portals

@esri' Joseph Kerski
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Access Boulder County GIS Portal

" =

< C'  [3 www.bouldercounty.org/gov/data/pages/gisdldata.aspx w =

2013 Flood | Home | Contact | Departments | Government | Elections | Jobs & Volunteer

] s

Open Space & Recreation Property & Land Roads & Transportation Environment Safety & Law Licenses, Permits & Records

Boulder County

Colorado

Government Geographic Information Systems (GIS) Downloadable Data

About Boulder County To access the data within the below files, use ArcGIS Explorer @ for layer packages and shapefiles and Google Earth @ for

Government KMZ format files. Roads may be accessed through the Colorado Depariment of Transportation @ (CDOT).
Bids & Purchasing

Boards & Commissions
Budget & Finance
Buildings & Personnel
County Ordinances
Departments
Economic Development
Elected Officials Building Footprints HTM (13 KB) KIMZ (6.5 MBYg) LPK (3.2 MBJf| ZIP (4.6 MB
Maps
GIS Downloadable Data .
News & Media rchacologically HTM (16 KB) KIMZ (50 KBJfF) LPK (340 KB)?) ZIP (18 KB

Public Meetings

“EFilter

Environmental

Conservation Areas HTM (53 KB) KMZ (176 KB LPK (285 KB)| ZIP (557 KB

Geological Hazards HTM (15 KB) KIMZ (699 KB LPK (1.0 MBJf| ZIP (706 KB

Mineral Resource Areas  HTM (15 KB) KIMZ (64 KB)E| LPK (134 KB)?| ZIP {66 KB

MNatural Communities,
Rare Plants, Riparian
Caorridors, Critical
Wildlife Habitat

HTM {519 KB) KMZ (130 KB LPK (203 KB)) ZIP (261 KB

Stgnificant Agrieulural pmy (17 kB) KIMZ (150 KBJE LPK (409 KBIF) ZP (151 KB

1, Floodplain (1).zip = ¥ show all downloads. .. x
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Save data sets locally, Add to ArcGIS Online via “My Content”

Add ltem

Add an item from your computer or reference an item on the Web.

The item is: | On my computer

File: Choose File |Floodplair|.zip

Supported Items
Contents: | Shapefile | =

Publish this file as a feature service
(Adds a feature service item with the same name.)

|Floodplair|

[Bnulder x] [Countv x] [ﬂnndplains »

Add tag(s)

ADD ITEM CANCEL

|4 Floodplain (1).zip v

¥ show all downloads... %
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Using ArcGIS Online Analytical Tools

¢ ArcGIS Online is a cloud-based GIS, not just an online set
of web maps. Hence, you can use it for conducting spatial
analysis.

¢ The spatial analysis capabilities of ArcGIS Desktop still
far exceed that of ArcGIS Online, given its 30 year head
start, but more analytical capabilities are being added
guarterly to ArcGIS Online.

¢ The spatial analytical tools in ArcGIS Online are easy to
use. They are accessed from the arrows to the right of
specific layers. Whether you see the analytical tools
depends on (1) if you are using an ArcGIS Online
organizational subscription, and (2) how the data are served
In ArcGIS Online (i.e. ideally, as services)
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Hands-On Activities

1. Plate Tectonics.
2. London cholera in 1854
3. Real Time Weather.

4. Floodplains and Geologic Hazards.

5. Crime.
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Hands-On Activity: Plate Tectonics

¢ Using Analytical capabilities in ArcGIS Online.

¢ Examine: Layers, CSVs, feature services, styling,
filtering, tabular work, statistics, analysis.

Questions include:
What is the spatial pattern of earthquakes?

Where did the deepest and most intense earthquakes
occur?

What is the relationship of the pattern of earthquakes to
plate boundaries?

@esri' Joseph Kerski
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Hands-On Activity: Plate Tectonics

¢ www.arcgis.com > Create folder for plate tectonics
analysis > Search for Plates 4 Types map > Save map in
your working folder.

¢ http://earthquakes.usgs.gov > Real Time Feeds and
Notifications > Spreadsheet Format.
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Hands-On Activity: Cholera Analysis, London
1854

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: What percentage of the cholera
outbreak cases are associated with the Broad Street well?

You will consider public water pumps, and locations with 1
or more deaths, in your assessment.
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Hands-On Activity: Cholera Analysis, London
1854

¢ Start with: www.arcgis.com > Create cholera folder >
Search for LearnArcGIS Cholera > Save it in your folder >

Then: A series of analytical steps designed to understand
the patterns of the cholera deaths and to compute a route
for Dr Snow and Rev. Whitehead to visit the cholera victims’

homes.

@esri' Joseph Kerski
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ArcGIS v LearnArcGIS Cholera

[ Details] || B8 Basemap ]

O [ &
Contents
¥} Soho

[¢| Cholera cases by
address

cEBAR| -

! Public water pumps

» ¥ Snow Map
3 Topographlc

Esri.com . Help . Terms of Use . Privacy
Contact Esri . Report Abuse

Modify Map « Sign In

Share %- Print ‘ @ Measure ﬂ!l Bookmarks [Find address or place Q]

AR /
Fitzrovia
/

2
o

—

Charing

/C'l,OSS \

B OWERED

R o)
23 —- (?'
< Q-\cﬁ"\ ¥ DoBH, 0S, Esri, HERE, Detorme, INCREMENT P, USGS, M..

12 4nnl
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Hands-On Activity: Real Time Weather

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: Examine patterns of temperature,
pressure, wind speed, and direction.

1) Symbolize weather variables: temperature, pressure,
wind speed/direction. Examine patterns.

2) Create an interpolated surface from the weather data for
1 variable (for example, temperature).

@esri' Joseph Kerski
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Continuous Surfaces from Point Data: Heat
Maps, Density Surfaces, and Hot Spot Maps

- A heat map shows the occurrence of a set of points
as a density surface. Heat maps use a point
density calculation to provide a graphical
visualization of the density of your data as a
smoothly varying set of colors from cool (low
density) to hot (high density). The Heat Map tool
(http://www.arcqgis.com/home/item.html?id=4{4666 71
p85f42058397a762778b9210) uses a Gaussian
blur to render the colors through contours that are
concentric circles with a Gaussian distribution from
a center point.
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The effect of this blurring is similar to viewing an image
through a translucent screen
(http://en.wikipedia.org/wiki/Gaussian_blur).

- The Calculate Density tool creates a density map from
point or line features by spreading known quantities of an
attribute across the map, resulting in a surface classified
from least dense to most dense. Uses a more
sophisticated tool than heat mapping, a kernel density

algorithm.

@esri' Joseph Kerski
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- A Hot Spot map shows the results of statistically
significant spatial clusters of high values (hot spots) and
low values (cold spots). A mathematical algorithm is

used and the results are expressed in terms of statistical
confidence.

- Both the Heat Map and Calculate Density tools indicate
the density of features. Hot spot maps show clustering

that is statistically significant, rather than just an
Indication of density.
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- Selecting Heat Map —> Options will allow you to change the

following: Change how the colors get applied to the density surface by
adjusting the position of the two handles on the color ramp slider. Make
the clusters become larger and smoother, or smaller and more distinct by
adjusting the area of influence slider. Use Symboils to select a different
color ramp. To have the map viewer calculate and set the optimal visible
range, click Suggest next to the Visible Range slider, or manually set it.

Calculate Density:

https://developers.arcgis.com/rest/analysis/api-
reference/calculate-density.htm

Find Hot Spots:

https://developers.arcgis.com/rest/analysis/api-reference/find-hot-
spots.htm

Heat map:

http://doc.arcgis.com/en/arcgis-online/create-maps/change-
style.htm#ESRI SECTION1 2DFD98C91EAE47A4BAE846E5DE75E97

@esri' Joseph Kerski
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Hands-On Activity: Real Time Weather

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: Examine patterns of temperature,
pressure, wind speed, and direction.

WWW. arcq |S .CcCom > ArcGIS v Real Time Weather Map Starting Point Modify Map & Sign In
. 5E Basemap | | ©2 Share | S Print | &3 Measure [ Bookmarks [Find address or place IQ]

Search: o @ & s :
= BB J320 8, o e -k f
R 990 0" o s_% 2 —
Contents N SRR i B Missdpse o o ,..,'-;-
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[] County Boundaries S, FEY o3 . ) ‘
. £ Pl ¢ o o0
Weath er Startl n g [) Current Temperature { S --, . GFEATH-’\"%l ‘ %
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Activity: Flood and Geologic Hazards
Analysis

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement. Because of recent devastating
floods that occurred in September 2013, the Boulder County
Office of Emergency Preparedness, hearing of your
excellent GIS skills, has asked you to prepare an
assessment of the most vulnerable lands in the county to
future flooding and the people on those lands.

You will consider floodplains, geologic hazards, land cover,
soils, and demographics in your assessment.

@esri' Joseph Kerski
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Activity: Flood and Geologic
Analysis

¢ www.arcgis.com > Create folder for flood hazards
analysis > Search for map: Boulder County Colorado

laza

rds

Hazards Analysis Starting Point > Open Map > Save in

your working folder.

ArcGIS ~ Boulder County Colorado Hazards Analysis Starting Point

Details || BE Basemap Share i Print | &3 Measure
< LV
3
> "

o @ & <

Contents

|#) Geologic Hazards of
Boulder County
EBEAaR| -

(¢ Floodplains of Boulder
County

» @Topographlc

.......................

Modify Map & SignIn

[]!,I Bookmarks [Find address or place

[2)

12
z

—— ]
A E
k“\/ve N~
i
] ™ s
= :& ?
> A " ' i .
Wl p
I T IEPFERSON preominds
|
# 4
Golden Gate ",
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Analysis Workflow

¢ 1. Filter Floodplains layer to only consider the true
floodplains. Filter geologic hazards layer to only consider
Major Hazards.

¢ 2. Proximity-> Buffer floodplains by 200 meters.

¢ 3. Dissolve the buffer’s internal polygons.

¢ 4. Manage Data-> Overlay-> Intersect the dissolved
floodplain buffers with Major Geologic Hazards.

¢ 5. Sort on Analysis Area and only consider the largest
polygons.

¢ 6. Data Enrichment, with Group Quarters and %
Wetlands.

@esri' Joseph Kerski
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Final Results

howe - Boulder County Colorado Floodplain Analysis Map
% Add ~ | HE Basemap

NEW MAP Joseph ~

Contents

¥ Enriched Intersect of
Dissolved 200m
Floodplain Buffers Major
Geol Hazards -
EnrichedLayer

Intersect of Dissolved
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Hazards Boulder County
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- Geologic Hazard
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Activity: Crime Analysis 1of5

1. Search for Lincoln_Crime. Save as crime_lastname
with proper metadata.

2. Police Stations>>Filter. name Is Team Station
(unique)

3. Police Stations>>Perform Analysis>>Use
Proximity>>Create Drive-Time Areas Time is 5 minutes.

ArcGIS + Lincoln Crime Modify Map & Sign In




Crime, 2 0f 5

4. Crime>>Perform Analysis>>Summarize Data>>Aggregate Points
5 Minutes from Team Station

- Field to group = offense

- Check Add Percentage

« ASSAULT 111 37.12%
AUTO THEFT 21 7.02%
LARCENY 167 35.85% Total Crime 299

Investigate table and graph created within the polygon.

4b. Next - > Summarize crime by grid cell.
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Crime, 30f5

5. Crime>>Change Style>>Heat Map
- Try additional analysis by offense:

- Filter for Assault

- Filter for Auto Theft

- Filter for Larceny

A heat map is a graphical representation of data where the
Individual values area represented as colors. No new data is
formed. The data is styled.
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Crime, 4 of 5

Density surfaces show where point or line features are concentrated. It
shows the predicted distribution throughout the landscape. A mathematical
algorithm is used and new data is produced.

- 6. Crime>>Perform Analysis>>Analyze Patterns>>Calculate Density

Options:
. Search Distance = Miles (Default)
. Clip Output to Lincoln

Number of Classes = 10

Output Area Units = Square Miles

@esri' Joseph Kerski 39



Crime, 50f 5

- Hot Spot Analysis identified statistically significant spatial cluster of
high values (hot spots) and low values (cold spots). A mathematical
algorithm is used and new data is produced.

- 7. Crime>>Perform Analysis>>Analyze Patterns>>Find Hot Spots

Options: Clip Output to Lincoln

- 8. Save.
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Alternative instructional approach: A new
road through the Serengeti?

¢ Using Analytical capabilities in ArcGIS Online

¢ Problem Statement: A new road is proposed through the
Serengeti to link ports on the Indian Ocean with Lake
Victoria. You will use spatial analysis to examine the route
of two proposed roads, assessing the impact of each on
wildlife migration and on the local ecoregions, and
examining alternatives to the roads themselves.

You will consider the two routes proposed, wildlife
migration, ecoregion, elevation, total length. Specifically:
wildlife migration within 5 km from proposed roads, length
of roads within each ecoregion.

@esri' Joseph Kerski
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rcGIS - A new road in the Serengeti? MODIFY MAP A signin

ome
2atures
ans

allery

»

elp

(¢ Proposed Roads in
Serengeti 1

Proposed Roads in
Serengeti 2

Y

Information about the
Proposed Roads

Wildlife Migration Route
Points

LY

0 ®

Summarize Wildlife
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Instructional Considerations

¢ You can have your stakeholders perform the analysis.

- Or -

¢ You can perform the analysis and have your stakeholders
analyze the results (as | do often with the Serengeti lesson).

- Or -

¢ A combination of the two.

- Or -

¢ Teach with visual analysis of patterns, linkages, and trends,
without the quantitative measures.
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Next Steps 1 of 2

¢ Access these maps in ArcGIS Online. They are all public. Go
through some of these analytical steps.

¢ Take the Going Places with Spatial Analysis MOOC - Esri.

°
@ esrl Industries Products Support & Services About Community Q

<]

Going Places with
Spatial Analysis

May 11, 2016 - June 22, 2016

Free Online Course - Sign Up Now to Join. Count Me In

Gain a deeper understanding of spatial data analysis.



Next Steps 2 of 2

¢ Examine “How to teach with the ArcGIS Platform” documents,
Including video on spatial analysis tools:

http://Iwww.esri.com/landing-pages/industries/education/higher-
education/teach-with-arcqis-platform

¢ Review video tutorials: A Deeper Dive with ArcGIS Online:
See playlist : http://www.youtube.com/geoqraphyuberalles
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